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Important Information 

Texas Instruments makes no warranty, either express or implied, 
including but not limited to any implied warranties of 
merchantability and fitness for a particular purpose, regarding any 
programs or book materials and makes such materials available 
solely on an “as-is” basis. 

In no event shall Texas Instruments be liable to anyone for 
special, collateral, incidental, or consequential damages in 
connection with or arising out of the purchase or use of these 
materials, and the sole and exclusive liability of Texas 
Instruments, regardless of the form of action, shall not exceed 
any applicable purchase price of this item or material. Moreover, 
Texas Instruments shall not be liable for any claim of any kind 
whatsoever against the use of these materials by any other party. 

Graphing product applications (Apps) are licensed. See the terms 
of the license agreement for this product. 

Apple, Adobe, Acrobat, Dreamweaver, eBook Reader, Flash, 
FrontPage, JavaScript, Macintosh, Macromedia, Microsoft, Paint 
Shop Pro, PhotoShop, and Windows are trademarks of their 
respective owners.  © 2003 Texas Instruments Incorporated. 
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Overview 

TI-Reader Converter application 

The TI-Reader Converter is a Windows® application that lets you 
convert text, HTML, or Open eBook (OeB) publication files to 
binary eBook (BEB) format for viewing using the TI-Reader App 
on the TI-89, TI-92 Plus, or Voyage™ 200 personal learning tool 
(PLT). Teachers, students, and curriculum developers can all use 
TI-Reader Converter. 

The TI-Reader Converter converts files up to 64K in size into a 
single output file. For files larger than 64K, the TI-Reader 
Converter creates up to nine additional file segments as needed, 
for a total of ten book segments. 

TI-Reader application 

The TI-Reader handheld software application (App) displays book 
files that have been converted for viewing on the TI-89, 
TI-92 Plus, or Voyage 200 PLT. 
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You use the TI-Reader App to page through an electronic 
document as you read it, plus you can: 

• Search for any word or phrase in the book. 

• Go instantly to the first page, last page, or any page number. 

• Add and use bookmarks. 

• Highlight important words or passages. 

• Add, edit, and view annotations. 

• Select a hyperlink and jump to the link’s destination within the 
same book. 

• View images along with the text. 

What is the process? 

The following steps provide an overview of the process of 
installing the software and then converting and viewing books. 

1. Install the TI-Reader App on your handheld device. 

2. Install the TI-Reader Converter on your Windows® computer. 
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TI-Reader Converter is available free from the Texas 
Instruments (TI) Educational & Productivity Solutions (E&PS) 
web site at education.ti.com/software.

3. Save the HTML, OeB, or text file to your computer. 

4. Use the TI-Reader Converter software to convert the file to a 
binary eBook (BEB) file compatible with your handheld device. 

5. Using the TI Connect™ software, transfer the converted BEB 
file to archive memory on your handheld device. Book files are 
automatically stored in a folder named books. (The folder is 
created automatically.) 

6. Use a TI-GRAPH LINK™ cable to transfer books from a 
computer to your handheld device. You can also use the 
TI-GRAPH LINK unit-to-unit cable to transfer books from one 
handheld device to another. 

7. Start the TI-Reader App and open a book. 

http://education.ti.com/software
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The TI-Reader App is a concept application that TI wants to share 
with our customers, educators, and students before the product 
definition and testing are complete. It is an alpha software 
version, and as such, it may contain imperfections, or the coding 
may be incomplete. 

TI invites your feedback concerning the functionality and 
educational value of the TI-Reader App. Please send your 
comments and questions to concept@list.ti.com.

Languages 

Instructions and application variables (AppVars) for these 
applications are available in English, French, and German.  

mailto:concept@list.ti.com
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Getting Started with TI-Reader Converter 

To start the TI-Reader Converter: 

• Double-click the TI-Reader Converter icon on your Windows® 
desktop. 

 — or — 

• Click Start > Programs > TI Tools > TI-Reader Converter.

Click Choose File, choose 
the type of file to be 
converted, and choose 
the file name. 

Enter a name for the new 
file, choose a file type, 
and click Choose Location
to specify where to save 
the file. 

If your source text has 
headings; select both 
font sizes. If it is 
unformatted, select one 
font size. Then click 
Convert.
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From this screen, you can: 

• Choose the file you want to convert. 

• Choose a device file type. 

• Choose a folder location for the converted file. 

• Choose the font sizes you want to include. 

• Initiate the conversion process. 

Choose File to Convert 

1. Click Choose File. The Choose File dialog box opens.  

2. In the Files of type field, choose one of the following: 

• Text (.txt) 

• OeB (.opf) 

• HTML (.htm or .html) 
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3. In the Look in field, browse through the list of files and select 
the file name. The selected file name appears in the File name 
field.  

4. Click Done to return to the TI-Reader Converter screen. The 
selected file name and path appear in the Choose File to 
Convert area. 

Save Converted Files 

To name your book file: 

Click in the Save As field, type a name for the converted file you 
are creating. 

Note File names must begin with a letter and can be no longer than 
eight characters. Names can include numbers as well as 
lowercase and uppercase letters but cannot include symbols or 
spaces.  



TI-89/TI-92 Plus/Voyage™ 200 PLT TI-Reader Converter and TI-Reader App Page 10 

To choose a file name extension: 

1. Click the down arrow to open the file type extension list.  

2. Select the extension that corresponds to your handheld 
device. 

 
To select Click 

Voyage 200 PLT file type .v2y  

TI-92 Plus file type .9xy 

TI-89 file type .89y 

The handheld device file type you choose sets the width of the 
text column for the converted file. The width of the column of text 
is narrower for a TI-89 than for a Voyage™ 200 PLT or a 
TI-92 Plus because the TI-89 display area is not as wide. 

To choose a folder location: 

1. Click Choose Location. The Choose Location dialog box 
opens. 
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2. Navigate to a folder on your computer where you want to save 
the file. 

3. Click Done.

Choose Device and Font Profiles 

The settings that are available depend on the device file 
extension you chose in the Save Converted Files area of the 
TI-Reader Converter window.  

• If you chose .89y (TI-89), the TI-89 Small and TI-89 Large 
options are available. 

• If you chose .v2y (Voyage 200) or .9xy (TI-92 Plus), the Small 
and Large font options are available for the Voyage 200 and 
TI-92 Plus. 
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The font sizes you choose to include determine the variety of 
fonts you are able to view on your handheld device. The default 
selection is large font only. If you select both small fonts and large 
fonts, your book file will be somewhat larger. 

• If you are converting a plain ASCII text file, you may want to 
select only one font size because the unformatted text will all 
be the same size anyway. 

• If you want the user to be able to choose between small and 
large fonts using TI-Reader on the handheld device, you must 
include both large and small fonts. Or you may want to include 
only the large font, resulting in smaller file sizes and easier 
viewing. 

• If you are converting an HTML file that includes heading tags, 
you can include both small and large fonts so that the 
headings will display in a large font and the body text will 
display in a small font. 

Convert 

1. Click Convert to begin file conversion. 

A notification message and progress indicator appear on the 
screen for as long as the conversion is in progress. 



TI-89/TI-92 Plus/Voyage™ 200 PLT TI-Reader Converter and TI-Reader App Page 13 

2. To interrupt file conversion, click Cancel at the bottom of the 
message. 

The TI-Reader Converter converts files up to 64K in size (about 
64,000 characters) into a single output file. When conversion is 
complete, a message confirms and displays the converted file 
name and location. 

For files larger than 64K, the TI-Reader Converter creates 
additional segmented files as required. Up to 10 segmented files 
may be created. 
 

Note The TI-Reader Converter displays a message when a file must 
be segmented. Click Continue or Cancel to proceed with or 
cancel the conversion.  

The TI-Reader Converter automatically names each segmented 
file by appending a file number to the file name. (Each file name is 
kept at a maximum of eight characters.) For example, consider a 
book named Sundown:

Number of Files:  File Name(s): 

1 (no segments) Sundown 

1 through 10  Sundow01, Sundow02, . . . 
Sundow09, Sundow10 
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If all the memory is available for TI-Reader books, the 
Voyage™ 200 can hold up to 45 file segments. Likewise, the 
TI-92 Plus and TI-89 can hold up to 10 file segments.  

When you open any segment in the TI-Reader App, the book 
appears as a single seamless document. 
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Getting Started with the TI-Reader App 

Viewing a book 

The TI-Reader App screen displays the contents of the book you 
open and includes these tools: 

• Menus along the top 

• Scroll bar along the right side indicating the progress made 
through the current book 

• Status line along the bottom, which includes the current page 
number, the total number of pages, and indicators to inform 
you if a bookmark (BKMRK) or annotation (ANNOT) is on the 
current page. 

Highlight 

Status line, 
with indicators

Scroll bar 

Menus 
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Status line indicators 

 

 

 

 

If you quit the TI-Reader App, start the App again later, and 
choose the Current book, the book opens to the last page you 
read. 

Note The number of pages in a book and the amount of text you can 
view on the screen vary depending on the font size you choose. 

Using menus to access options 

Menus let you open files, change text font sizes, obtain 
information about the TI-Reader App, go to another page, and 
use bookmarks, highlights, and annotations.  

To select a menu, press the corresponding function key on your 
handheld device. For example, when you see , press ‡ to 
open the GoTo menu. 

Indicates the 
current page 
number and the 
total number of 
pages in the book 

Indicates that 
this page has a 
bookmark Indicates that 

this page has 
an annotation 
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Changing the font size of text 

You can choose to view books in either small or large font size. 
When you open a book, the TI-Reader App displays the text in 
large font by default. 

Note Small and large font sizes are available only if both large and 
small fonts are selected when the file is converted using the 
TI-Reader Converter.  

To change the font size: 

1. Press ƒ 2:Format.

2. In the FORMATS dialog box, on the Font Size option, select 
Large or Small, and press ¸.

Tip You can also open the FORMATS dialog box using this 
shortcut: ¥ Í (TI-89) or ¥ F. 
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Book files formatted for a particular device 

You cannot read a book designed for one of the other handhelds 
on a TI-89 because the lines of text do not fit within the width of 
the TI-89 display. 

TI-Reader App books are converted using TI-Reader Converter 
on a Windows® computer. During conversion, book files are 
given the file type extension for the appropriate handheld device: 
.v2y for the Voyage™ 200 PLT, .9xy for the TI-92 Plus, and .89y 
for the TI-89.  

Converting a book file for a particular handheld device sets the 
line lengths for the converted file, and the number of lines for 
each page in the book.  

The width of the column of text is narrower for a TI-89 than for a 
Voyage 200 PLT or a TI-92 Plus because the TI-89 display is not 
as wide. The number of lines for a TI-89 are fewer because the 
TI-89 display cannot show as many lines per page. 
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Long books in segments 

For files larger than 64K, the TI-Reader Converter creates 
additional segmented files as required. Up to 10 segmented files 
may be created. When you open any segment in the TI-Reader 
App, the book appears as a single seamless document. 

When you transfer the file segments for an entire book to your 
handheld device, make sure you have all of the segments. If any 
of the segments are missing, you cannot open the book in the 
TI-Reader App. 

If your handheld does not have enough memory available for all 
the segments, make more room available: 

1. Back up all your Apps and data files (application variables) to 
your computer’s hard disk using TI Connect™ software. 

2. Press 2 ° and delete any files you do not currently 
need from the handheld. 
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Navigating in the TI-Reader App 

Using the cursor keys 

Use the cursor keys to move from page to page and link to link: 

• Press C or D to display the next or previous page. 

• Press ¹ C or ¹ D to display the last or first page. 

• Press A or B to move to the next or previous hyperlink. 
 

Note With … 1:Add Highlight selected, pressing C or D moves 
the cursor from line to line. Pressing A or B moves the cursor 
from character to character. For more information, see 
Highlights.

Using the GoTo menu 

You can use the GoTo menu to go to the first or last page, a 
specified page number, or a word or phrase. 

To go to the first or last page in a book, press ‡ 1:First Page or 
‡ 2:Last Page.
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Tip You can also use the ¹ C and ¹ D shortcuts to go to the first 
and last pages of a book. 

To specify a page number: 

1. Press ‡ 3:Page Number.

2. In the GoTo Page Number dialog box, enter the page number 
and press ¸. The selected page appears. 

To find a word or phrase:  

1. Press ‡ 4:Search.

2. In the Search dialog box, enter the word(s) and press ¸.
The cursor advances to the next occurrence of the word or 
phrase. 

 
Note If you want to search for special or international characters, 

press 2 ¿ and use the arrow keys to select a character 
from one of the CHAR menus. 
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Using hyperlinks 

Many books that were converted from HTML documents contain 
links to take you from one page to another. Links appear on the 
screen as underlined text.  

When more than one link appears on a page, the first link is 
highlighted.  

• To select a link, highlight the link using the left or right cursor 
keys and press ¸.

• To follow the highlighted link, press ¸.

• To return to the link, press N.

Note You cannot add links using the TI-Reader App. Links must be 
created within an HTML document prior to being converted with 
TI-Reader Converter. 
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Using Bookmarks 

Adding a bookmark 

1. Go to the page where you want to create a bookmark, and 
then press „ 1:Add Bookmark.

2. In the Add Bookmark dialog box, type the name of the 
bookmark and press ¸.

Finding a bookmark 

1. Press „ 2:GoTo Bookmark.
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2. In the GoTo Bookmark dialog box, choose a bookmark from 
the list, and press ¸. The bookmarked page appears. 

Removing a bookmark 

1. Press „ 3:Remove Bookmark.

2. In the Remove Bookmark dialog box, choose a bookmark from 
the list, and press ¸. The bookmark is deleted. 
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Using Highlights 

Highlighting text 

1. Press … 1:Add Highlight.

Note Watch the status line at the bottom of your screen for hints 
about what to do next as you add a highlight. 

2. Use the cursor keys to navigate to a word or group of words 
you want to highlight.  

3. While pressing ¤, use the cursor keys to select text to 
highlight. You can highlight any words on the current page. 

4. Press ¸. The selected text remains highlighted. 
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Once you choose the Add Highlight command, TI-Reader is in 
Highlight Mode until you press ¸ to complete the action, or 
press N to cancel the action. You must complete or cancel the 
action before you can use other features of the TI-Reader app. 

Viewing the highlights 

To make highlights visible or invisible: 

1. Press ƒ 2:Format.

2. In the FORMATS dialog box, on the View Highlight option, 
select On or Off, and press ¸.
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Finding the highlights 

1. Press … 2: GoTo Highlight.

The cursor advances to the first highlight in the document. 

2. Navigate through the document as follows. 

- Press B to advance to the next highlight. 

- Press A to advance to a previous highlight. 

- Press N to stop finding highlights. 
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Removing a highlight 

Note If there are no highlights on the current page, … 3: Remove 
Highlight is disabled. 

1. Display the page from which you want to remove highlights. 

2. Press … 3: Remove Highlight.

The Remove Highlight dialog box opens. 

3. Press ¸. The highlight is removed from the text. 

Remove all highlights 

1. Press … 4: Remove ALL Highlights.

The Remove All Highlights dialog box opens. 

2. Press ¸. All highlights are removed throughout the book. 
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Using Annotations 

You can enter and save comments, or annotations, in the books 
you view. Annotations appear on the screen only when you 
choose to view them. 

Adding an annotation 

1. Press † 1: Add Annotation.

2. In the Add Annotation dialog box, enter a name for the 
annotation. 

3. Press D to move to the Text field and enter your annotation. 

4. Press ¸.

Note The annotation text often breaks in the middle of words rather 
than between words to allow more text to be viewed.  
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Finding an annotation 

1. Press † 2: GoTo Annotation.

2. In the GoTo Annotation dialog box, press B to open the list of 
annotation names. 

3. Select an annotation and press ¸. The page with the 
annotation you selected is displayed, and the selected 
annotation appears. 

4. Press ¸ to close the annotation. 

Viewing an annotation 

1. Press † 3: View Annotation.

2. In the View Annotation dialog box, press B to open the list of 
annotation names for the displayed page.  

 
Note The list of annotation names includes only annotations on the 

displayed page. If there are no annotations on this page, 
† 3:View Annotation is disabled. 
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3. Select an annotation and press ¸. The selected 
annotation appears. 

Editing an annotation 

1. Press † 4: Edit Annotation.

1. In the Edit Annotation dialog box, press B to open the list of 
annotation names. 

2. Select an annotation and press ¸.

The annotation opens in the Editing Annotation window. 
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3. Use the cursor keys and the keyboard to edit the annotation as 
necessary. 

4. To finish editing and close the window, press ¸.

Note The list of annotation names includes only annotations created 
on the displayed page. If there are no annotations on this page, 
† 4:Edit Annotation is disabled. 

Removing an annotation 

1. Press † 5: Remove Annotation.

2. In the Remove Annotation dialog box, press B to open the list 
of annotation names. 

3. Select an annotation and press ¸. The annotation is 
deleted. 
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Note The list of annotation names includes only annotations created 
on the displayed page. If there are no annotations on this page, 
† 5:Remove Annotation is disabled. 

Removing all annotations 

1. Press † 6: Remove ALL Annotations.

2. In the Remove ALL Annotations dialog box, select Yes. All 
annotations are deleted. 
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File Size and Capacity Guidelines 

The following can help you estimate how much text can be 
converted into a 10-segment book and how much text is likely to 
fit on a TI handheld device. 

General information 

• When converting plain text files without graphics, with only the 
large font included, 345 to 350K is roughly the maximum size 
text file you can convert without exceeding TI-Reader 
Converter’s limit of 10 file segments per conversion. 

• After resetting the memory and deleting everything except the 
TI-Reader app on a TI-92 Plus, you may not have enough 
memory available to transfer all 10 file segments. We were 
only able to load eight segments on the device before running 
out of memory. The TI-89 handheld will have similar results. 

• The Voyage™ 200 PLT has more memory and will be able to 
load all 10 segments, assuming other data and applications 
can be deleted to make room for the book segments. 

 
Note Upper-ASCII international characters (for example, vowels with 

an accent, umlaut, or tilde) are supported. 
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Sample test results 

• A text file (approximately 38% of a medium-length novel), 
before conversion, was 261K.  

• The file converted to eight book segments. 

• The size of the text file was approximately 81 pages, or 45,014 
words, or 219,338 characters (without spaces.) 
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Tips for Converting HTML Files 

Facts and limitations 

• Any text within a table is ignored and not converted. 

• Generally, TI-Reader Converter can convert most HTML 2.0 
files. Features introduced in HTML 3.0 or 4.0 are generally not 
supported. 

• TI-Reader Converter processes the following HTML tags: 
<html>, <head>, <body>, <frameset>, <p>, <h1>, <h2>, <h3>, 
<h4>, <h5>, <h6>, <ul>, <ol>, <dl>, <dir>, <menu>, <pre>, 
<li>, <dt>, <dd>, <caption>, <colgroup>, <thead>, <tfoot>, 
<tbody>,  <a>, <br>, <img>, <frame>, <noframes>, <map>, 
<area>, <option> (only lists its items), <div>, including space 
characters. 

• Other HTML tags other than listed above are ignored.  

• JavaScript is not supported.  

• Hyperlinks within the HTML document are supported, but 
hyperlinks to other documents do not work and will return an 
error message. 

• Many Web pages on the Internet are too complex to be 
converted.  
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Tips 

• Keep your HTML files as simple as possible. 

• Avoid special formatting. Stick to tags such as headings, 
paragraph, unordered lists (bullets), ordered lists (numbered 
steps). 

• Do not use tables in your HTML. If text is already in an HTML 
table, copy and paste it into ordinary paragraph text. 

• Keep your images very simple and small. 

• If you use hyperlinks, make sure they link to a destination 
within the current HTML file.  

• To create files that display two font sizes, use heading tags 
and paragraph tags in your HTML. For example, use <h1> for 
Heading 1, <h2> for Heading 2, and <p> for body paragraphs. 
Then when you convert the HTML file with TI-Reader 
Converter, select both small and large fonts under Choose 
Device and Font Profiles. When you open the book using 
TI-Reader on your handheld device, the headings are in large 
font and the paragraphs are in small font. 
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• If you want to convert a complex Web page, try saving the file 
using Internet Explorer (or other Web browser), and then open 
the file in a program such as Microsoft® FrontPage®,
Macromedia® Dreamweaver®, or Microsoft Word. Then 
simplify the page by removing text and images from tables, 
deleting hyperlinks to other Web pages, and generally 
eliminating features that TI-Reader Converter does not 
support. 
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Tips for Converting Images 

TI-Reader Converter can convert images that are referenced in 
the HTML file you choose to convert.  

• GIF, JPEG, and PNG formats are supported.  

• SWF (Flash™) images or other formats that require a plug-in 
are not supported. 

The image is converted to a very simple monochrome bitmap 
format, which supports only two colors—black and white, or a 
foreground color and a background color.  

• Shades of gray are not retained.  

• Images with multiple colors are converted to dithered patterns 
to approximate the various colors.  

To avoid poorly converted images, you may want to simplify them 
before you convert the HTML file that references the images. 

• You can use a bitmap image editor such as Jasc Paint Shop 
Pro™ or Adobe® PhotoShop® to reduce the number of colors 
in a GIF or PNG image to eight, or reduce the quality and size 
of a JPEG image. 
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• If you have a large quantity of images, you can save time by 
batch processing the image files. 

The steps for these tasks will vary depending on the image editor 
you use. See the help or documentation that accompanies your 
chosen application. 
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Application Messages and Warnings 

TI-Reader 

Error Message Comment/Suggestion 

The destination to the link you 
have selected is not available. 
Either the link destination is in 
another file, or it was not 
included during file 
conversion. 

May occur when you try to select a link 
within a book file, typically one that has 
been converted from HTML. 

If you converted this file using the 
TI-Reader Converter, open the original 
HTML file and test the link there. If the 
link jumps to a another HTML file, the 
link will not work in TI-Reader.  

Please transfer all segments 
of book (book1, book2, …) to 
the device. 

Occurs when you try to open one 
segment of a book, but not all of the 
segments were transferred from your 
computer. All segments must be 
present. 

The name for the bookmark 
you entered already exists. 
Please choose another name. 

Occurs when you try to add a bookmark 
with the same name as a previous 
bookmark. 

The name for the annotation 
you entered already exists. 
Please choose another name. 

Occurs when you try to add an 
annotation with the same name as a 
previous annotation. 

BKEX file has reached its 
maximum limit of 64K. No 
more annotations or 
bookmarks can be added. 

The book extra (BKEX) file, which 
TI-Reader uses to store a book’s 
annotation, highlight, and bookmark 
information, cannot exceed 64K.  
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TI-Reader Converter 

Message Comment 

Please choose a file to 
convert. 

Occurs when you click Convert before 
choosing a file to convert. 

Please choose a font profile. Occurs if you deselect the font options 
and then click Convert. You must select 
at least one font size to be included in 
the book file. 

Please choose a location to 
save the converted file. 

Occurs when you click Convert before 
choosing a location to save the 
converted file. Click Choose Location 
and navigate to the folder where you 
want to save the converted file. 

The file you are converting will 
need to be segmented. All 
segments must be transferred 
to the device to read the 
(filename.ext). 

Occurs when you convert a file that 
results in an application variable that is 
greater than 64K. TI-Reader Converter 
informs you that the file will be broken 
into numbered segments, and that you 
must transfer all segments to your 
handheld device. 
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Message Comment 

Conversion Incomplete! The 
program has exceeded the 
maximum number of 
segmented books for the 
selected device. The original 
file must be subdivided into 
smaller files. See 
documentation for more 
information. 

Occurs when the original file is too large. 
The TI-Reader Converter cannot convert 
more than a maximum of 10 segmented 
files. You must break the original file into 
two or more smaller files.  

1. In your text editor or HTML editor, 
highlight some of the content from the 
original file, and then click Edit > Cut.

2. Click File > New to create a new file, and 
then click Edit > Paste.

Be careful how you name the files when 
you save them. Because the TI-Reader 
Converter uses numbers to name file 
segments, consider using letters instead 
of numbers to keep track of sequential 
content from one file to another. 

File name must begin with a 
letter and must not exceed 
eight characters. The name 
may be alphanumeric, but 
must not include any other 
characters. 

Occurs when you enter an unacceptable 
name for the file in the Save as: field. 
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Installing the TI-Reader App 

Detailed Flash App installation instructions are available from 
education.ti.com/guides.

You will need:  

• A TI-89 / TI-92 Plus / Voyage™ 200 PLT with the latest 
Advanced Mathematics Software Operating System. 
Download a free copy from education.ti.com/softwareupdates.

• A computer using either Microsoft® Windows® or Apple®

Macintosh® operating system software. 

• A TI-GRAPH LINK™ cable that connects the 
TI-89 / TI-92 Plus / Voyage™ 200 PLT and a computer. The 
cable is available for purchase from retail stores, online 
retailers, and instructional dealers. You may also purchase the 
cable from the TI Online Store at education.ti.com/buy.

• TI Connect™ software, which is compatible with most current 
TI graphing products. 
— or — 
TI-GRAPH LINK software for either the TI-89 or TI-92 Plus. All 
connectivity software is available free from 
education.ti.com/latest.

http://education.ti.com/latest
http://education.ti.com/buy
http://education.ti.com/softwareupdates
http://education.ti.com/guides
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Installing the TI-Reader Converter Software 

You will need a computer with Microsoft® Windows®

95/98/2000/NT/ME/XP.  

(TI-Reader Converter requires Windows, but you can install the 
TI-Reader App on your handheld using TI Connect™ software 
and a Macintosh® computer.) 
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Starting and Quitting the App 

For help using the TI-89 / TI-92 Plus / Voyage™ 200 PLT, refer to 
the comprehensive guidebook for your handheld device at 
education.ti.com/guides.

Starting the TI-Reader App 

1. With the Apps desktop turned on, press O, highlight 
TI-Reader, and press ¸.
— or — 
With the Apps desktop turned off, press ¹ O, highlight 
TI-Reader, and press ¸.

2. Select one of the following: 

- Current opens the last book viewed at the last page 
displayed. 

- Open lets you select a book. 

- New functions exactly as Open. 

Quitting the TI-Reader App 

Press 2 K from any screen. 

http://education.ti.com/guides
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Deleting an App 

Deleting an App removes it from the handheld device and 
increases space for other Apps. Before deleting an App, consider 
making a back up copy for reinstallation.  

1. Quit the application. 

2. Press 2 ° to display the VAR-LINK [ALL] screen. 

3. Press 2 ‰ (TI-89) or ‰ to display the list of installed 
applications. 

4. Select the application you want to delete. 

5. Press ƒ 1:Delete. The VAR-LINK delete confirmation dialog 
box displays. 

6. Press ¸ to delete the application. 
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Concept Application Evaluation License 

Agreement 

(Including Preview, Prototype, and Demo Apps) 

BY DOWNLOADING THE SOFTWARE AND/OR DOCUMENTATION YOU 
AGREE TO ABIDE BY THE FOLLOWING PROVISIONS.  

1. LICENSE: Texas Instruments Incorporated (“TI”) grants you a license to use 
and copy the software program(s) (“License Materials”) contained on this 
diskette/CD/web site. You, and any subsequent user, may only use the 
Licensed Materials on Texas Instruments calculator products. 

2. RESTRICTIONS: You may not reverse-assemble or reverse-compile the 
Licensed Materials. You may not sell, rent, or lease copies that you make. 

3. COPYRIGHT: The Licensed Materials are copyrighted by TI or the third 
party licensor. Licensee agrees that he/she will not delete the copyright 
notice, trademarks or protective notices from the Licensed Materials or 
copies made during installation.  

4. SUPPORT: The Licensed Materials are provided by TI with the 
understanding that only limited support for this concept application may be 
available from TI. 

5. TESTING: Licensee acknowledges that he/she understands that TI has not 
in all cases subjected concept applications to rigorous testing and that the 
concept application may cause problems with his/her calculator, including 
its use in any kind of shared environment. Further, it is possible for a 
concept application to cause calculator crashes or lock ups which may be 
difficult to recover from. You are advised that use of the concept application 
is AT YOUR OWN RISK.  
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6. WARRANTY: TI does not warrant that the Licensed Materials will be free 
from errors or will meet your specific requirements.  
THE LICENSED MATERIALS ARE MADE AVAILABLE "AS IS" TO 
LICENSEE.  

7. LIMITATIONS: TI MAKES NO WARRANTY OR CONDITION, EITHER 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, REGARDING THE LICENSED MATERIALS.  
 
IN NO EVENT SHALL TI, ANY THIRD PARTY LICENSOR, OR TI'S 
SUPPLIERS BE LIABLE FOR ANY INDIRECT, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, LOSS OF PROFITS, LOSS OF USE OR 
DATA, OR INTERRUPTION OF BUSINESS, WHETHER THE ALLEGED 
DAMAGES ARE LABELED IN TORT, CONTRACT OR INDEMNITY.  

8. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
LIMITATION MAY NOT APPLY.  

9. RESTRICTED RIGHTS: The Licensed Materials are provided with 
Restricted Rights. Use, duplication or disclosure by the United States 
Government is subject to restrictions as set forth in subparagraph [c](1)(ii) 
of the Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 or in subparagraph [c](1) and (2) of the Commercial 
Computer Software - Restricted Rights at 48 CFR 52.227-19, as applicable.  
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TI-Reader Converter License Agreement 

By downloading/installing the software and/or documentation, you agree 
to abide by the following provisions. 

1. LICENSE: Texas Instruments Incorporated (“TI”) grants you a license to 
use and copy the software program(s) and documentation from the linked 
web/CD page (“Licensed Materials”). During installation, the software 
program(s) will be copied to the hard drive of your computer. You may not 
make any other copies of the Licensed Materials. 

2. RESTRICTIONS: You may not reverse-assemble or reverse-compile the 
software program portion of the Licensed Materials that are provided in 
object code format. You may not sell, rent, or lease copies that you make. 

3. COPYRIGHT: The Licensed Materials are copyrighted. Do not delete the 
copyright notice, trademarks, or protective notice from any copy that you 
make. 

4. WARRANTY: TI does not warrant that the program or Licensed Materials 
will be free from errors or will meet your specific requirements. The 
Licensed Materials are made available “AS IS” to you or any subsequent 
user. 
 
Although no warranty is given for the License Material, the media (if any) 
will be replaced if found to be defective during the first three (3) months of 
use, when the package is returned postage prepaid to TI. THIS 
PARAGRAPH EXPRESSES TI’S MAXIMUM LIABILITY AND YOUR SOLE 
AND EXCLUSIVE REMEDY. 

5. LIMITATIONS: TI MAKES NO WARRANTY OR CONDITION, EITHER 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 
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IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, REGARDING THE LICENSED MATERIALS. 

6. Restricted Rights: The Licensed Materials are provided with Restricted 
Rights. Use, duplication, or disclosure by the United States Government is 
subject to restrictions as set forth in subparagraph [c](1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or 
in subparagraph [c](1) and (2) of the Commercial Computer Software – 
Restricted Rights at 48 CFR 52.227-19, as applicable. 

In no event shall TI or its suppliers be liable for any indirect, 
incidental or consequential damages, loss of profits, loss of use or 
data, or interruption of business, whether the alleged damages are 
labeled in tort, contract or indemnity. 

Some states or jurisdictions do not allow the exclusion or limitation of 
incidental or consequential damages, so the above limitation may not 
apply. 
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Page Reference 

This PDF document contains electronic bookmarks designed for 
easy on-screen navigation. If you decide to print this document, 
please use the page numbers below to find specific topics. 
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